How to cite this Edition:


Editors & Authors
Dr. Thorsten Dresing, Thorsten Pehl
dr. dresing und ehl GmbH
Deutschhausstraße 22A
D-35037 Marburg
Germany

Christian Schmieder
www.squaremethodology.com
1015 Grant St. Apt#1
53711 Madison, Wisconsin
USA

2. English Edition February 2013
(1. English Edition March 2012)
(1. German Edition July 2011)
Marburg: Self-published
All rights reserved.

The manual can be downloaded for free:
http://www.audiotranskription.de/english/transcription-practicalguide.htm

It would be appreciated if you recommend our manual on your blog, your website or via facebook, twitter etc. Distribution of this manual via other servers than http://www.audiotranskription.de/english is prohibited. This ensures that all readers receive the newest version.

Cover design:
Lars Zimmermann, ARTWORX3D

ISBN 978-3-8185-0497-7
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>3</td>
</tr>
<tr>
<td>Qualitative Interviews</td>
<td>5</td>
</tr>
<tr>
<td>Why should one conduct qualitative interviews?</td>
<td>5</td>
</tr>
<tr>
<td>Conducting Successful Interviews</td>
<td>9</td>
</tr>
<tr>
<td>Common issues</td>
<td>17</td>
</tr>
<tr>
<td>Transcription: The challenge of producing a text</td>
<td>21</td>
</tr>
<tr>
<td>Rules are necessary!</td>
<td>21</td>
</tr>
<tr>
<td>A system for simple transcription</td>
<td>27</td>
</tr>
<tr>
<td>A complex transcription convention: GAT2</td>
<td>34</td>
</tr>
<tr>
<td>Transcription conventions in conversation analysis</td>
<td>37</td>
</tr>
<tr>
<td>How long does it take to transcribe?</td>
<td>39</td>
</tr>
<tr>
<td>Useful tips</td>
<td>41</td>
</tr>
<tr>
<td>Remarks concerning anonymization</td>
<td>42</td>
</tr>
<tr>
<td>Expecting and avoiding transcription errors</td>
<td>44</td>
</tr>
<tr>
<td>Can speech recognition software do my work for me?</td>
<td>45</td>
</tr>
<tr>
<td>Use transcription software – not iTunes</td>
<td>46</td>
</tr>
<tr>
<td>Step-by-step guide for f4 (Windows) and f5 (Mac)</td>
<td>47</td>
</tr>
<tr>
<td>Time stamps are useful!</td>
<td>50</td>
</tr>
<tr>
<td>Qualitative data analysis with f4analyse</td>
<td>51</td>
</tr>
<tr>
<td>Tutorials / Practical Hints</td>
<td>65</td>
</tr>
<tr>
<td>How to choose a recording device</td>
<td>65</td>
</tr>
<tr>
<td>Hints for recording &amp; handling files in particular situations</td>
<td>65</td>
</tr>
<tr>
<td>Recording telephone interviews</td>
<td>74</td>
</tr>
<tr>
<td>Recording phone conversations with Skype</td>
<td>76</td>
</tr>
<tr>
<td>Converting audio files</td>
<td>81</td>
</tr>
<tr>
<td>Noise Removal</td>
<td>82</td>
</tr>
<tr>
<td>Trimming audio files</td>
<td>84</td>
</tr>
<tr>
<td>Data security and recovering deleted data</td>
<td>85</td>
</tr>
<tr>
<td>Cited works / References</td>
<td>89</td>
</tr>
<tr>
<td>The authors</td>
<td>92</td>
</tr>
</tbody>
</table>
Preface

Dear reader,

This handbook is intended for everyone who wants or needs to conduct, transcribe and analyze qualitative interviews. It aims to provide basic guidance for those wondering: „How should I go about this?“

The book was originally written because we felt that an accessible and practice-oriented introduction to the field of transcription didn’t exist yet was urgently needed. Since its first edition we have significantly expanded the manual, providing an overview of the steps necessary for a research project – from interview preparation to transcription to the new chapter in this edition: interview analysis.

We’ll show you how to prepare your interviews and how to record them. In the second part of the manual you’ll learn about the best methods for writing down your interviews. It is important to us to convey how that can be done in methodical, rule-governed and technically correct ways. Part Three is devoted to data analysis. We’ll provide an overview of general steps in qualitative analysis no matter what methods are applied, as well as show how this can be done with the help of the QDA-Software f4analyse.
Finally, we have compiled a number of useful tips, e.g., on how to reduce noise and distortions in your recordings or on how to recover deleted data. But let’s get right to it now. We wish you good luck with your interviews, their transcription and exciting insights for your research projects.

Thorsten Pehl und Thorsten Dresing

Marburg, January 2015.
Why should one conduct qualitative interviews?

If you are operating on a tight schedule you better set aside this guide right now. Planning, conducting, transcribing and analyzing qualitative interviews takes a lot of time. The preparation, conduction and transcription alone usually takes 10 to 15 times the duration of the actual interview. The time required for the subsequent analysis depends on many factors. Kuckartz et al. suggest a minimum of 60 times the interview length for a simple and rather descriptive qualitative study.\(^1\) Hence, students simply won’t have the time for large sample sizes or representative studies.

So why in the world should one go through the trouble of investing that much time into a qualitative project with interview data? Wouldn’t it be much easier and more efficient to conduct a quantitative survey?

\(^1\) This time calculation includes all relevant steps: development of research question, development and testing of question guide, conducting interviews, transcription, case-based analysis, category-based analysis and completion of study report (cf. Kuckartz et al. 2008).
Yes and no. Let us introduce three arguments that demonstrate in what ways and in which areas your research can benefit from the analysis of qualitative interviews.¹ This will help you decide whether qualitative interviews are useful for your particular research topic and whether you want to embark on the exciting journey into qualitative interviewing.

### Generating Information and Learning New Things

Imagine a situation where there is not a lot of information or knowledge available on your research topic. In such a case generating and testing hypotheses is difficult if not impossible. In order to gain a first impression of the topic you might have to talk to contemporary witnesses or other people involved. That is exactly what the research group Aumeister experienced in 1976 as its members looked into the professional situation of teacher trainees for the first time. Only in the course of many conversations with the trainees a phenomenon that later became known as *practice shock* was able to emerge. This approach requires fundamental openness and a great deal of curiosity.³

---

¹ When we speak of ‘qualitative interviews’ we assume that qualitative analysis will be applied. While hybrid forms exist, such as the quantitative analysis of qualitative data, we don’t refer to them in the following chapters (cf. Kuckartz 2012: 13ff.; Bernard/Ryan 2010: 4-7). Furthermore, we limit our guide to qualitative interview data although qualitative analysis can be applied to a variety of other types of data, e.g., pictures, news articles, music, videos etc., however (cf. Kuckartz 2012: 13ff.). See also Mayring/Gläser-Zikuda/Ziegelbauer 2005; Reichertz/Englert 2011; Mikos/Wegener 2005.

³ One’s own openness is of course limited by socialization, experience and
In qualitative research presuppositions or hypotheses do not shape the analysis, but the opposite is the case: an essential feature of qualitative interviews is that they contribute to the generation of hypotheses and development of theories.⁴

**Fewer Facts, More Meaning, Diverse Facets**

Qualitative methods of analysis are used to investigate complex processes, social phenomena and the construction of meaning. Here are two example research questions: “How do graduates deal with unemployment?” or “What do unemployed graduates’ problem-solving strategies look like?”

It is not about answering concrete characteristic attributes such as “How many graduates are unemployed?” or “How many graduates end up working in under qualified positions?”

Basically, you are interested in questions that cannot be answered by looking at a scale. Interviewees might elaborate, ponder, add background information and search for explanations instead of giving a straight answer. It is likely that exciting new information will emerge as a “by product” rather than in direct answers to your questions. In presuppositions (cf. Kuckartz 2012: 29ff.; Kelle 2007).

⁴ Cf. Lamneck 2010, 80ff.
this vein, no member of the *Aumeister* group mentioned above asked the young teachers straight out: “Are you suffering from a *practice shock*?”

Not only will you learn how your interview partners evaluate certain topics, you will probably also learn how the people in question arrive at that evaluation and which other aspects they regard relevant in connection to it. Thus, interview data does not only provide answers concerning what an interviewee says, but also why and how the person expresses motives, presuppositions and patterns of argumentation. The interview enables you to understand why an individual tells a story a certain way (as opposed to a different way). Structures of communication as well as constructions and interconnections of meaning thus become comprehensible and analyzable. Qualitative analysis can uncover aspects of a topic that had been deemed irrelevant or had not even been considered previously. From here, conclusions and interpretations can be generated and ideally bundled into theoretical concepts.

**More consistency**

Perhaps you have at some point filled out a long written survey without experiencing much involvement. Let’s say someone is interested why you live in Paris and hands you a survey to fill out. It is somewhat
obvious that the choice between prefabricated answers such as “It’s a great city” or “I was assigned to move here” will produce different information in terms of both content and attitude than a conversation starting with the question “So, how did you end up studying here in Paris?”

Due to the communicative nature of a conversation the interviewee will (have to) produce more stringent narrations. The interlocutor can directly indicate whether he or she understands or not. It is also possible to ask concrete questions about additional details that might have surfaced only in the course of the interview. Furthermore, interview partners’ non-verbal cues and signals can be perceived and included in the analysis. Good examples for such signals are periods of silence or reluctant answering behavior. Paying attention to such contextual data helps to avoid false conclusions or misinterpretations.

If you need further arguments in favor of qualitative approaches, see Kuckartz et al. (2008, 66p.) for a detailed elaboration on the added value of qualitative analysis.

**Conducting Successful Interviews**

By now you might be excited to do qualitative interviews. The preparation is quite manageable: You need to find interview partners, you
have to plan how you would like to structure your interview and you need the necessary technical equipment, e. g., an audio recorder. But what questions are you going to ask? How do you best phrase them? And what should you expect from an interview situation generally? Let’s start by taking a closer look at the questions you can ask.

**Asking ‘good’ questions**

No matter the type of interview, one question always will come up: “How do I ask the ‘right’ questions?” In terms of topic and content you will have to answer this for yourself, but we can give you some important advice on the phrasing of questions.

Just ask several questions right at the beginning, repeat them in different words a couple of times only to then offer an example answer and close with “That’s right, isn’t it?”

But seriously: there are things you should consider, both when developing your interview guide and during the actual interview.

---

5 In order to choose the methodologically suitable type of interview we recommend you consult Lamneck (2012, p. 321ff.). It offers a practical overview of the different types and characteristics of interviews, e.g., problem-centered interviews, expert interviews, focus groups, narrative interviews, etc. Based on the suitable interview type and your research question you then develop a guide and questions for your survey. For us, a guided interview is not its own methodological “species”, but rather an umbrella term for all interviews in which the interviewer uses a “cheat sheet” for support.
The purpose of questions in a qualitative interview is to outline the topic to the interview partner and to create narrative incentives. Thus, ask simple questions. A question is ‘simple’ when it is comprehensible and similar in style to the interviewee’s everyday life, and if it only inquires about one aspect.

*Kruse* (2014, 222) mentions some very good aspects that are useful in formulating questions that won’t just produce monosyllabic answers like “Yes” and “No”, but that will animate the interviewee to elaborate. Our suggestion: First generate your own questions, write them down and then critically assess them using the following checklist:

<table>
<thead>
<tr>
<th><strong>Do’s</strong></th>
<th><strong>Don’t’s</strong></th>
</tr>
</thead>
</table>
| Questions stimulating narrations: “Please describe...” | Closed questions: “Were you happy / satisfied with this or did this bother / dissatisfied you?”
| | BETTER: “How did you experience this?”
| “How satisfied were you with this?” | “How satisfied were you with this?”
| Follow-up questions: “What happened then?”, “What else does that make you think of?” | Yes/no questions: “Did you accept the job?”
| | BETTER: “What happened after you got the job offer?”
| Processes-oriented questions: “How did that come about?” | Asking for justifications: “Why did you do this?”
| | BETTER: ”How did it come about that you ..?”
| **Open questions**: reflect upon your own concepts contained in the questions! |
| **Suggestive and judgmental questions**: “In Turkey you must have grown up rather traditionally. How did you feel about this after you migrated?” |
| **Provocative questions**: use only sparsely and in a goal-oriented, conscious manner; use only toward the end of the interview or if the interview dynamics seem stagnant. |
| **Brief, comprehensible questions** |
| **Complicated questions, cascading questions, multiple-choice-questions** |
| **Answerable questions!** |
| **Questions transcending the participant’s knowledge**: “What did your boss think about this?” |
| **Directly or indirectly asking the research question itself**: “How would you describe your concept of fatherhood?” |
| **Soft questions**: “Please, tell me a little bit about your experience with online shopping.” |
| **Questions that sound like written language or asking “quick like a shot” / mechanically** |
| **Modal particles**: kind of; like; a bit; avoid verbs in the subjunctive! |
| **Premature questions on “facts” ruin the narrative dynamics** |
| **Ask for “facts” at the end of the interview** |
| **Participants have the speaking privilege.** |
| **Participant determines when or if the interview is over**: “Is there anything you did not have the chance to talk about, but which is important to you?” |
| **Interviewer ends the interview**: “Thank you for your time, I will get back to you if I have further questions.” |
Practice interviewing!

Your interview guide provides the structure of your interview. But how does your interview partner, who isn’t familiar with your methodological considerations, react? Are you able to ask the questions in a natural and fluent way without focusing too much on your guidelines? Test interviews are helpful in determining whether and how you yourself and your interviewees are handling the questions and the interview situation. Plan on doing test interviews and recording them. Also, think about a few feedback questions for your “test candidates” that you can go over together later in order to reflect upon your test interview (e.g. “How did you feel in the interview situation?” or “Where would further explanation have been helpful?”).

Initial pointers on research ethics

All participants should receive some preliminary information about your research project, the institution you and your research are affiliated with, and information concerning the duration and location of the interview. You should also include clear statements concerning anonymity (To what extent will the interviewees be identifiable, and what measures are taken to prevent this?) and confidentiality (Who will see the data? For how long? Where will it be stored? For how long, and in which formats?)
Be aware of your institution’s requirements concerning the informed consent form (e.g. Institutional Review Board (IRB) or other ethics committees), and thoroughly inform yourself about best practices at your institution, in your field, in the countries in which you generate your data and work with your data, and also keep in mind ethical requirements of publishers or journals in which you intend to publish your research. (On the construction of informed consent forms, cf. Seidman 2006, for a critical discussion of informed consent forms and ethical practice, cf. Punch 1986).

**Mastering the beginning of an interview**

You lay the foundation for a positive interview atmosphere when you first contact your participants. A good way of winning your interviewees’ trust is to introduce and explain your research project to them. This includes information on how you will treat the data you collect. Issue a confidentiality agreement that specifies how you will ensure the anonymity and confidentiality of the collected data. It should contain agreements on exclusively anonymized data use as well as on the appropriate attention to data security.

The beginning of the interview poses the best chance for creating an open and friendly atmosphere. Explain to your interview partner why you are conducting the interview and how it will take place. Get him
or her “on board” concerning the interview topic and acknowledge his or her willingness to participate. It’s all right to talk about your research topic in general, but do not go into detail about concrete research goals or interim results.

It is quite unusual for most people to have an intense conversation with a stranger. This is why interviewees frequently make mistakes – due to the unfamiliarity of the situation. Hopf (2006) names seven typical problems. We have converted them into practical advice:

1. Only ask if you are genuinely interested.
2. Avoid leading questions, mirrored feedback or interpretations.
3. Hold back as much as possible and do not try to steer the conversation in a particular direction. Assume the role of a talk show host. It is your job to initiate the conversation, but the guest always remains in the focus of interest.
4. Do not judge or comment on your interview partner’s statements! Even if it’s hard, avoid empathetic comments such as “Oh, how sad.” Signal your interest by nodding, affirmative noises like “uh-huh” and an occasional “I see” instead.
5. Let your interview partner finish talking. Remain silent from time to time even after the interviewee has finished in order to allow him or her to express tentative ideas or slowly developing thoughts. Include such breaks in your schedule and don’t be
afraid of silent moments.

6. You don’t have to follow your guidelines chronologically. It’s better to pursue topics as your interview partner brings them up during the conversation.

7. Avoid bringing up topics twice. If some of your questions have already been answered “accidentally”, don’t read them out again just because they are in your guide.

Preparation the recording equipment

Interviews are usually recorded for later analysis. While notes can certainly be useful, they are insufficient for most methodological approaches. Digital recording devices work well for recording interviews (for detailed recorder reviews and recommendations see www.audiotranskription.de). For interviews with only one participant, using a smartphone can be a stopgap solution. However, since you will probably spend many hours listening to your material, we recommend making a clear, high quality recording a priority. The crackling and chirping of a mediocre recording might not bother you during a quick listen, but will become annoying after the first few hours of transcription.
Check how and if your recorder works. Do so before the interview and make a few test recordings. This will spare you from having to deal with malfunctions, empty batteries or other technical problems during the interview. For further information see the detailed chapter on digital interview recording on p. 46 in this handbook.

In addition to your recording device you should also bring pen and paper for making quick notes during the conversation. After the interview you should write down your impression of the participant and how you experienced the interview. Document as well which parts of the conversation you consider essential, where you deviated from your guidelines and any contextual information you consider important.

**Common issues**

Even if you are well prepared, equipped with interview guidelines and technology, excited and highly motivated during your first interviews, you will probably be confronted with a number of problems even the best preparation cannot avoid. We have compiled a list of them here, which we hope will make it easier for you to deal with these difficult situations.
“Interviewee is very emotional” – It is possible that the person interviewed reacts much more emotionally to your questions than expected. In this situation it is important to just listen and let the interview partner talk. However, feel free to end or pause the conversation. Your interview partner should discuss deep emotional issues with appropriate people, not with you. You may and must set boundaries here.

“Coaching / therapeutic setting” – It happens that the interview partner turns to you for advice or asks you questions back. You should think about how to react and where to draw the line. Otherwise an interview can easily turn into a therapy session.

“Answers are too long, or too short” – Your exertion of influence in an interview is a balancing act and a fundamental problem of qualitative interview research. Keep in mind that your role is to define the topic. Therefore it is legitimate to interrupt your interview partner if he or she deviates too much from the topic. Phrases like “I’m interested in what happened with X. Can we go back to that?” enable you to bring the conversation back to topic in an appreciative manner. Continually reserved answers can mean that the topic is emotionally
charged. Do not consider this a disturbance, but rather an expression by your interview partner. When you are sure that it is more than initial shyness, bring it up (meta-communication). Thus you can check the connection with the topic. Say, for instance: “You seem reserved. I’m not sure if that has to do with the topic? Can you tell me something about this?”

“Disturbances / Interruptions” – Of course there will be all kinds of disturbances – a cell phone ringing, a door opening, a coughing fit, someone having to use the restroom, you going over time, the phone connection breaking down; and in the end you realize that the recorder malfunctioned. Stay calm. A simple disturbance probably won’t be a big deal. In the worst case it may affect your and your interviewee’s concentration, but the interview can be continued. Should your recording equipment fail, make notes of what you still remember (good thing you brought that pen and paper). For work-intensive or especially significant interviews that cannot be repeated, play it safe and use a second recording device.

“Language / technical terms” – Think about how you want to deal with linguistic particularities. Do you both speak the same language and if
not, do you understand each other’s languages well enough to understand semantic aspects? What do you do with technical terms or slang you don’t understand?6

“Role Conflicts” – Depending on your research question and your interviewees’ situation or position, role conflicts may emerge. Depending on whom you’ll be interviewing, you should be prepared for certain role conflicts and how you’ll deal with them. 7

Thus prepared, your first interviews should go well. Once they are stored on your computer as digital audio files, the next step awaits: transcription.

Transcription:
The challenge of producing a text

Transcription (lat. trans-scribere = to rewrite) is the transfer of an audio or video recording into written form. A transcript usually originates from simply typewriting the recorded content. Typically, conversations, interviews or dictations are subject to transcription.

Verbal statements are ephemeral and what we remember from conversations is often sketchy. Transcription aims at overcoming this problem by supporting memory. In a transcript, speech is registered in writing and therefore made accessible for analysis. One the one hand, one wants to represent speech in as much detail and in as multifaceted a way as possible in order to provide the reader with an accurate impression of the conversation and thus facilitate its reconstruction. On the other hand, too many details and too much information can make a transcript difficult to read. There is thus a tension between the opposing poles of accurate representation and practical limitations.
The transcription process is obviously paradoxical: with the aspiration to accurately represent the multi-faceted verbal discourse, you create a written text that is a linear, one-dimensional document. Ultimately, producing a transcript is a dilemma oscillating between realistic representation and practically possible presentation or compression. Hence the challenge of transcription lies in knowing this discrepancy and in dealing with it as adequately as possible with regards to your methodology and topic.

Anyone transcribing or working with transcripts should be aware that a transcript will never be able to fully represent the interview situation. Too many elements factor into communication and it is impossible to transcribe them all. Even a transcript closely guided by phonetics neglects non-verbal aspects such as odor, room and time setting, visual aspects, facial expressions and gestures. As one cannot include everything, one must focus on certain aspects. These aspects will vary depending on your research objective or intended use of the transcript or situation, respectively.

*Leaving out – or including, or transforming – certain aspects of recorded speech may radically change the content a transcript conveys to its readers (especially if they do not have the chance to listen to the*
recording, or if they have not been present in the recording situation). An example: A researcher asks a manager whether there will be any job cuts the following year. The manager takes ten seconds to think, rubs her chin, looks down and softly replies “Nope”. If the transcript only recorded “No” instead of including pause length and facial expressions, the reader would probably come to quite a different interpretation.

In simple transcripts, paraverbal and non-verbal elements of communication are usually omitted. Dialect and colloquial language is approximated to standard language. The focus of simple transcripts lies on readability. It is easier to learn to produce such a transcript and the transcription takes less time. These transcription conventions prioritize content. Well-known conventions like those by Kallmeyer and Schütze (1976) and Hoffmann-Riem (1984) focus on this goal.⁸

A detailed transcript based on a complex set of transcription rules is necessary if the subsequent analysis does not merely focus on the semantic content of a conversation. In such cases, prosodic elements (e.g. intonation, primary and secondary emphasis, volume, speed and pitch) are included. If necessary, a phonetic transcription is added, e.g.

in dialect research) and non-verbal phenomena are documented in a more complex way.\(^9\)

To illustrate the difference between a simple and a more detailed transcript, we have included two short transcript passages below. They originate from the same recording, but they have been transcribed according to different conventions.\(^10\)

\(^9\) While simple transcripts can be easily produced in word processors and specialized programs such as f4, more complex transcriptions need partitures in order to represent an increased amount of complexity. Transcriptions in partiture also call for specialized data analysis software in order to be produced and managed (eg. ELAN or Transana).

\(^{10}\) Excerpt from GAT fine transcript, cf.: http://www.mediensprache.net/de/medienanalyse/transcription/gat/gat.pdf, p. 35 (accessed on 08/16/2010).
Rules are necessary!

**Simple transcript**

S1: ...or whether they'll get divorced after all.

S2: Hm. (...)

S1: This is still. (...) It is a transition.

S2: Our former neighbors, they are a good example for this. (...) Married for thirty years (...) the last kid was finally out of the house, took off to study, (...) left, you know, to Berlin.

**Complex transcript**

S1: =<<dim> or WHEther they'll get divorced ↑`after all.>

S2: ˇhm,

(- -)

S1: <<pp> this is still - > ((breathes out for 2.1 sec)) <<p> t'is a ↑`trans-

S2: our former neighbors ↑`they are a good example for this

(- - -)

err (- - -)

↑ married for THIRty years °hh

the last kid (. ) `finally outta-the

´HOUSE,

took off to STUdy, (-)

´LEFT, =´you know, °h

to ber´LIN, °h

You have probably noticed that the simple transcript allows faster access to the content of the conversation. It dispenses with intonation details, which makes the transcript easier to read. The detailed transcript on the other hand provides the reader with a better impression of the speakers themselves by including intonation and vernacular.
Participant 2, for instance, comes across as dedicated and interested due to the repeated use of strongly emphasized syllables. This aspect does not become as clear in the simple transcript, whereas the speaker’s frequent breaks and thus delayed speech are more apparent there.

You should decide how and what to transcribe according to your research method, your research expectations and pragmatic reasons. You should not “just start” transcribing.

Ask yourself first:

- For what kind of analysis do I produce my transcript?
- What information should the transcript therefore include?
- Is it important to include emphases?
- Is it important to represent vernacular or dialects? And so on..

Clearly defined rules do not only make your transcripts comprehensible to the scientific community, but also to you yourself as you type-write and read them later.
A system for simple transcription

Kuckartz et al. provide “deliberately simple and quickly attainable transcription rules which considerably “smoothen” speech and set the focus on content” (2008, p. 27).

We have applied this system in many extensive research projects, each of them involving several transcribers at a time. Through the feedback from transcribers, editors and researchers who have processed hundreds of interview hours, we have specified the transcription rules and added a few suggestions in order to ensure consistency, and to obtain a better basis for the subsequent analysis.

The system is subdivided into three parts:

1. Transcription rules
2. Tips for consistent notation
3. An example transcript

---

11 We presently provide transcription services. We collaborate with 40 transcribers on various qualitative research projects, which has further informed the development of the transcription system over the past few years.
The underlying transcription rules

1. Transcribe literally; do not summarize or transcribe phonetically. Dialects are to be accurately translated into standard language. If there is no suitable translation for a word or expression, the dialect is retained.

2. Informal contractions are not to be transcribed, but approximated to written standard language. E. g. “gonna” becomes “going to” in the transcript. Sentence structure is retained despite possible syntactic errors.

3. Discontinuations of words or sentences as well as stutters are omitted; word doublings are only transcribed if they are used for emphasis (“This is very, very important to me.”) Half sentences are recorded and indicated by a slash /.

4. Punctuation is smoothed in favor of legibility. Thus short drops of voice or ambiguous intonations are preferably indicated by periods rather than commas. Units of meaning have to remain intact.

5. Pauses are indicated by suspension marks in parentheses (...).

6. Affirmative utterances by the interviewer, like “uh-huh, yes, right” etc. are not transcribed. EXCEPTION: monosyllabic
answers are always transcribed. Add an interpretation, e.g. “Mhm (affirmative)” or “Mhm (negative)”.

7. Words with a special emphasis are CAPITALIZED.

8. Every contribution by a speaker receives its own paragraph. In between speakers there is a blank line. Short interjections also get their own paragraph. At a minimum, time stamps are inserted at the end of a paragraph.

9. Emotional non-verbal utterances of all parties involved that support or elucidate statements (laughter, sighs) are transcribed in brackets.

10. Incomprehensible words are indicated as follows (inc.). For unintelligible passages indicate the reason: (inc., cell phone ringing) or (inc., microphone rustling). If you assume a certain word but are not sure, put the word in brackets with a question mark, e.g. (Xylomentazoline?). Generally, all inaudible or incomprehensible passages are marked with a time stamp if there isn’t one within a minute.

11. The interviewer is marked by “I:”, the interviewed person by “P:” (for participant). If there are several speakers, e.g. in group discussions, a number or a name is added to “P” (e.g. “P1:”, “Peter:”).
12. The transcript is saved in rich text format (.rtf file). Name the file according to the audio file name. E. g. interview_04022011.rtf or interview_smith.rtf.

You can reach a higher degree of detail by including the following additional rules. You should only choose the rules that are suitable for your data and scope of analysis. Naturally, it will then take longer to complete the transcript.

**Additional rules**

1. Discontinuations are marked by `/: “I was worri/ concerned.” Word doublings are always transcribed.

2. Pauses are indicated by suspension marks in parentheses, corresponding to the pause length from one second (.) to three seconds (...), and the (number) of seconds for longer pauses.

3. Affirmative noises und fillers (“uh-huh, um, yeah”) are transcribed. All the participant’s utterances, including fillers, are transcribed.

4. Speech overlaps are marked by `//. At the start of an interjection, `// follows. The simultaneous speech is within `// and the person’s interjection is in a separate line, also marked by `//.

5. Dialects are written as they are spoken.
Tips for a consistent notation

These aspects concern notation and help making transcripts consistent despite several transcribers.

1. Symbols and abbreviations such as *percent* and *meter* etc. are spelled out.

2. Contractions and short forms are transcribed exactly as they are spoken, e.g. ‘can’t’ instead of ‘cannot’ or ‘stats’ instead of ‘statistics’

3. Concerning capitalization, words in different languages are spelled according to the rules of the English language.

4. Numbers are transcribed as follows:
   a. Zero to twelve are spelled out, larger numbers are transcribed as numerals.
   b. Numbers that make short words are also spelled out, especially round numbers: twenty, hundred, three thousand.
   c. Decimals and equations are always written in numerals.

   Thus: “4 + 5 = 9” and “3.5“.
d. Roughly estimated figures are spelled out, accurate figures are written in numerals, e.g. “The fifty million Euros in state subsidies”.

e. Follow established conventions regarding spelling. Street addresses, page numbers, telephone numbers, bank account numbers, dates etc. are never written out. For instance: “on page 11” or “16 Broad Street”.

5. Idioms are transcribed literally.

6. If direct speech is quoted in a recording, the quote is put in quotation marks: and then I said “Well, let’s see about that.”

7. Single letters are always capitalized (“B like in bird”).

8. Enumerations: one capital letter without parentheses.
Sample transcript

I: So, what do you expect from your new field of study in Hamburg? #00:01:01–0#

P: Well, first and foremost I want to learn a lot of new things about criminology and the legal branch. Well, my major was educational science, and my minor subjects were sociology and peace and conflict studies in MARBURG. And now, I would like to get to know the legal side of it better, and meet new people and experience new things. And I also want to (explore?) a completely new profession. #00:01:26-1#

I: Okay, and what you expect regarding collaboration //between teenagers?// #00:02:11-2#

P: //SO far, I don’t have// any concrete ideas and for the profession or for criminologists, there is no, a specific profession or professional (…), how do you say, doesn’t exist, well a profession, and then also you can do a LOT of different things. #00:02:32-4#
A complex transcription convention: GAT2

As opposed to the simple notation from the previous chapter, more complex notation conventions put an additional focus on “how something was said”. This makes the qualitative analysis of the data’s phonetic and phonological features possible. The main difference lies in the documentation of intonation (emphasis), the exact length of pauses, overlapping speech, sudden cut-offs and informal contractions, as well as a generally closer representation of what was said, including vernacular.

The transcription system GAT (Gesprächsanalytisches Transkriptionssystem – Conversation Analytic transcription system) is widely used in German speaking countries (cf. Dittmar 2004, pp. 150 – 164). The linguists who developed it in 1997 were motivated by the goal of unifying and combining existing systems. While the GAT introduced in 1998 distinguished between basic and fine transcripts, the advanced version GAT 2 introduced in 2009 allows for finer distinctions (cf. Gesprächsforschung (10/2009), pp. 353 – 402). A rudimentary minimal transcript is followed by a basic transcript, which can be expanded into a fine transcript, according to the project’s requirements.

A minimal transcript can conveniently be produced with the software f4, as it only transcribes phrases containing emphases, pauses, speech
overlaps, laughter, etc., while leaving out details like accents and finer intonations. However, for a basic transcript, f4 reaches its limits in terms of usability. The free software PRAAT (www.praat.org) is more convenient and accurate for such transcripts.

PRAAT has the advantage of displaying not only the sound file, but also an oscillogram and a spectrogram. It also displays a variety of values extracted from the sound file. This allows users to read accentuations and the voice pitch and thus complement the subjective auditory impression.

But there is a catch: PRAAT produces a transcript in the Text-Grid file format, which can only be accessed in PRAAT. The files are absolutely unsuitable for further processing in a regular text editor.\(^\text{12}\)

Researchers at the University of Freiburg in Germany have developed and award-winning extensive online tutorial for beginning GAT2 users: http://paul.igl.uni-freiburg.de/GAT-TO.

The rules and conventions of GAT2 can be learned through a series of examples and texts.

---

\(^\text{12}\) The free application EXMARaLDA (http://www.exmaralda.org/) and its corresponding partiture-editor are able to import TextGrid files created in PRAAT, and can display them as text files.
Here are some examples for transcripts according to GAT2:

**Example 1: Every intonation phrase get its owe line**

01 A: How about this idea
02 each flower get its own pot
03 "hh but not a different fertilizer
04 B: why not
05 A: (-) it would be too expensive otherwise

**Example 2: Intonation phrases of a single speaker are strung together and separated by an “|”.** This transcript uses fewer lines, but can only with difficulty be expanded into a fine transcript.

01 A: How about this idea | each flower get its own
02 pot | "hh but not a different fertilizer |
03 B: why not
04 A: (-) it would be too expensive otherwise

**Example 3: A basic transcript** already contains considerably more information:

26 S2: an:d !EV!ery time he called the poLICE,
27 and he started ARGuing with the NEIG [bors,=right, ](1.2)
28 S1: [phhh hohoho]
29 S2: and if someone just once used their HORN,
30 he stood out there in NO time;
31 and started YELLing;=
32 =i'll call the poLi:CE

---

Transcription conventions in conversation analysis

Using the transcription conventions developed in the English discourse on conversation analysis is another – quite similar – option. The system of transcript symbols in linguistic conversation analysis is, just as the more elaborated transcripts in GAT, quite complex (for an overview of transcription notations, see Jefferson 2004).\textsuperscript{14} However, Emanuel Schegloff did compile a more simple transcription convention for the social sciences based on the notation developed by Gail Jefferson. It is available on the American Sociological Association’s (ASA) website: http://www.asanet.org/journals/spq/transcriptions.cfm\textsuperscript{15}

Another list of conventions is available on Charles Antaki’s tutorial website on conversation analysis:

http://www-staff.lboro.ac.uk/ssca1/notation.htm.

\textsuperscript{14}This is no coincidence: The conventions developed in GAT are following – and modifying – the transcription principles of CA as developed by Jefferson (cf. Selting et al 2009: 353).

\textsuperscript{15}Note that this website does unfortunately not display the arrows indicating higher & lower pitch, as well as the sideway arrows indicating relevant lines for analysis. Those symbols are correctly displayed on Antaki’s tutorial site.
Sample Transcript according to Schegloff/ASA

26 S2: .hhh an:d ↑EVery time he called the poLICE,
27 and he started arguing with the neig[bors,=right,](1.2)
28 S1: [((laughs))]
29 S2: and if someone just once used their HORN,
30 he stood out there in no time;
31 and started yelling;=
32 <<↓i’ll call the poLI:CE>

Amongst other details, this transcript features emphases (underlined text), it indicates louder passages (written in CAPITALS), more slowly spoken passages (in < >), and different levels of voice pitch (↓↑). As in the case of any transcription notation, you should assess which aspects of the recording are important to you, and then decide whether to include them into your transcript.

There is a series of educational tools for learning how to transcribe according to the conversation analysis' transcription notation. Two great places to start are Emanuel Schegloff's Transcription Project website: http://www.sscnet.ucla.edu/soc/faculty/schegloff/TranscriptionProject/index.html .

And Charles Antaki's tutorial website on conversation analysis: http://www-staff.lboro.ac.uk/ssca1/notation.htm.
How long does it take to transcribe?

Never underestimate the time it takes to produce a transcript! A lot of times one isn’t aware that the transcription of one interview may take days. This can easily jeopardize the fragile schedule of a research project with a deadline.

The duration of transcription depends on how fast you type and on the complexity of the transcript. Although it is difficult to pinpoint an exact number of hours required, it is possible to estimate a reliable time frame. The fastest transcription speed we have measured was a ratio of 1:3. That means that it took the transcriber about three hours to transcribe one hour of an interview. However, the transcriber was able to set this record speed only because he or she only typed for an hour, did not proofread the transcript for a second time, while using simple transcription rules. Applying complex transcription rules takes considerably more time. Some researchers report that it took them between 30 and 60 minutes to transcribe one minute of data (cf. Ehlich & Reede 1994, p. 4 and Lange 2008, p. 48). Bad recording quality also has an adverse effect on transcription time.

According to our experience and our review of relevant literature, one should estimate five to ten hours to transcribe and proofread one hour of interview data according to basic transcription rules (cf. Dresing &
Pehl 2010, p. 726). As opposed to the purely content-focused systems, a GAT2 basic transcript already requires partial interpretation. This translates directly into an increase in transcription time: assuming adequate practice, 5 minutes of audio recording may be transcribed within 1.5 to 2 hours. Under ideal circumstances, this means a ratio of 1:20. But if one factors in breaks to maintain concentration, one is closer to a ratio of 1:25. This illustrates that transcribing verbal data is a time-consuming process. In order to complete a transcription as quickly as possible, transcription software has proven useful. We further recommend working with key combinations instead of working with a mouse. Using a foot pedal can lead to a further acceleration of 10-20%. Keep in mind: breaks are necessary. It may sound trivial, but one cannot transcribe for 8 hours straight; at least not without medical support. A break of 5-10 minutes per hour in front of the screen is recommended. Thus, more than 6 hours of transcription per day are not realistically possible without raising the error rate above normal.

An example: you should expect 50 to 100 hours of work for ten hour-long interviews when using a simple transcription system. This translates into 2-4 weeks if you transcribe for 4-6 hours a day – that’s a whole month! This is a big chunk of time if you only have three months to work on your bachelor’s thesis, for instance.
Useful tips

1. Trivial, but crucial: save your transcript from time to time and make backup copies. If possible, store them on a different device.

2. Qualitative data analysis software like f4analyse or MAXQDA usually works with paragraph numbers. Transcription and analysis software usually generate paragraph numbers automatically. Transcripts can also be printed directly from these programs.

3. Should you work with Word instead, you can still create paragraph numbers. Highlight the text and click on the numbering button and the paragraph numbers will appear.

4. Line numbers can also be added in Word at a later point. Open the file containing the transcript in Word (up to the 2003 edition) and go to ‘File’>‘Page Layout’. Now select the ‘line numbers’ button.
Remarks concerning anonymization

Normally, transcribed text must be anonymized. This can be done by searching and replacing words in a word processor, or directly within the transcription software. For example, simply search for “Mr. Smith” and replace it with “Mr. XYZ”. This is of course only the first step – you will have to read the text carefully in order to identify passages that might compromise your participants’ anonymity.

It is important to anonymize data as far as possible directly after transcription. Not only does this protect your participants, it also saves time (and prevents stress) in the long run. Anonymizing data via ‘search & replace’ might change the line numbers in your word processing document – this would mean that you’d have to check all of your references in your report again if you anonymized after analysis & writing. Also, qualitative data analysis software does often not feature a ‘search & replace’ function – so you’d have to manually search and anonymize every piece of text within the program, which is much more painstaking than doing it in a word processor (especially because the ease of handling tasks of word processing is much lower in QDA software). Of course you can export your data from QDA software into a text document and anonymize it in a word processor – but then you suddenly deal with two versions of your data, and you will always have to cross-check references in your research report.
Anonymizing data for your research reports is an important task – if you make mistakes, or if you miss to anonymize only one important piece of information, the whole effort was in vain, and the identities of your participants may be revealed. Thus, it is better to do this work as early as possible: Research projects tend to be more stressful towards the end, when deadlines are pressing – it is very exhausting to do delicate work such as anonymizing at this time. Also, anonymizing right after transcription gives you the chance to find mistakes or missing anonymizations while you analyze; this is an extra safety net for you and your participants.
Expecting and avoiding transcription errors

Every first version of a transcript contains mistakes. These errors are usually checked and corrected in a second round in which you read and listen to the interview at the same time. Surprisingly, few mistakes are pure spelling mistakes. Omitted, replaced or added words are more problematic. These errors stem from the listener’s natural tendency to complete or correct the speaker’s statements while listening. This subconscious correction leads to a distortion of the original statement. E. g. without noticing, one transcriber typed “black hell” instead of “black hole” (One wonders if that had anything to do with the transcription work.). Isabelle Chiari (2006) demonstrates that untrained transcribers produce a mistake in almost every paragraph. Close to 37% of these mistakes lead to a semantic distortion of the statement. It is therefore advisable to proofread the completed transcript at least once and ideally several times, or have another person proofread the text (“two man rule”). This way, most mistakes are tracked down reliably. If it is not possible to involve a second person, you should proofread the text yourself after some time has passed.
Can speech recognition software do my work for me?16

Unfortunately, this is not possible yet. As of today, speech recognition software is still inadequate for the transcription of interview recordings. We know this because we have run thorough and repeated tests. Automatic speech recognition of interview or group discussions is simply impossible with the software currently available. The situation is exacerbated by the fact that interviews often contain dialect or colloquial language, which speech recognition software is unable to identify. Additionally, the software cannot register breaks or atmosphere.

The only option for using speech recognition for transcribing interviews is to train the program to recognize your own voice. You can then listen to and repeat the interview. This means you are sitting in front of your computer with headphones and a microphone and re-narrate the whole interview. But even compared to the “hunt and peck method” (100 characters per minute) this does not mean an improvement in terms of time. The time saved is consumed by the proofreading time. According to our tests, using speech recognition software in this way was still no match for regular transcription.17

16 Go to our website www.audiotranskription.de/spracherkennung for further literature, comparison tests and additional information on the possibilities and limits of speech recognition software in academia. (Content in German language)

17 Cf. Dresing, Pehl & Lombardo (2008)
Use transcription software – not iTunes

Even though speech recognition software does not work yet, you do need some type of software in order to transcribe. The first and obvious choice would be to use a digital music player and a word processor. But well-known applications like Windows Media Player or iTunes are not useful for transcribing data. They lack essential features supporting and shortening the transcription process, i.e. slowing down playback speed without distorting pitch, automated intervals for rewinding when the tape is paused (which enables you to hear the last few words again after you paused the tape), time stamps, text elements, key combinations or foot pedal controls.

Specific programs for audio transcription were not available during our PhD research in 2004. Hence, we developed such a program ourselves: f4. (Unfortunately it came out a bit too late to help us with our own interviews.)

By now, f4 is one of the best-known transcription programs and has been downloaded over 450,000 times. For Mac users we have developed the version f5. We constantly improve both programs and make them available on www.audiotranskription.de.
f4 and f5 support you in your transcription, i.e. in typing out audio or video recordings. The programs facilitate your work by slowing down the replay speed (without distorting pitch), easy controls using the F4 and F5 keys (hence the name), an automatic rewind after pauses, the (automatic) insertion of time stamps and text blocks via keyboard shortcuts. Transcripts produced in f4 and f5 are saved as rtf files (including time stamps), a widely compatible word processing format.

1. Installing the program

Download f4 for Windows or f5 for Mac OS from http://www.audiotranskription.de/english/. You will also find detailed instructions on how to install the program on the site.

2. Setting up the software

Open the program. First, set a location for saving backups (you
can do this in the ‘preferences’ menu). Now open an audio or video file via the ‘file’ tab or drag-and-drop the desired files into the main f4/f5 program window. Next, customize the sound output volume, the replay speed and rewinding/forwarding intervals. The standard settings normally accommodate most users; only the replay speed should be reduced when transcribing passages with fast or overlapping speech.

When transcribing two-person conversations you can activate a feature that automatically inserts the name/abbreviation of the alternating speakers. You can suppress this function at any time by holding down the shift key and the enter-key to create a new paragraph.

3. Transcribing quickly and conveniently

The ‘F4’ key (or ‘F5’ key in f5 for Mac) controls the core functions of our software: starting and stopping the playback and automatically rewinding the recording in short intervals. The functions of f4 & f5 can also be operated via the ‘F4’/’F5’ key when other programs are running in the foreground, such as continuing to navigate through an audio file while checking analysis results in a word processing program. Use the ‘F3’ and ‘F5’ keys (or ‘F4’ and ‘F6’ keys on Mac) to rewind or fast-forward the audio. By using a foot pedal, the programs can be controlled even quicker. (Also, in both programs, spoken audio remains
decipherable while rewinding or fast-forwarding).

4. **Time stamps – inserted manually or automatically**

Time stamps are important for orientation within a transcript and allow for a quick reference to the original audio source. They are either automatically inserted at the end of each paragraph, or they can be inserted at any time by pressing the ‘F8’ button. In f4 & f5 as well as in the qualitative data analysis software MAXQDA or ATLAS.ti, these time stamp references are active links. In both programs, clicking on the time stamp triggers the playback of the relevant part of the audio or video recording. When saving a file in f4 & f5, you can choose whether to save the transcript with or without time stamps. If you transcribe movies or movie fragments, you can define a time offset, so that time stamps do not start at zero, but with the respective time within the movie.

5. **Tutorials** - We have created a series of video tutorials which can be viewed on our website:

www.audiotranskription.de/english/f4.htm
Time stamps are useful!

We have already mentioned time stamps earlier. But their potential is so extraordinary, that we would like to cover them in more detail. Time stamps are simple numbers indicating a respective position on the audio or video track. In f4 and f5, you can click on them directly and the respective sequence is played right away.

Time stamps enable you to quickly check the transcript for possible errors, ideas about a person or semantic ambiguities much later in the analytic process. The great thing about time stamps is that they do not only work in f4 and f5 themselves, but also in some of the programs researchers use worldwide. These programs recognize time stamps from f4 and f5 and enable you play back the respective audio sequence with one click. This makes it easy to check the original recording for analytical questions, or to review controversial or odd transcript passages. Many times, being able to quickly and conveniently listen to an original passage provides valuable clues for interpretation, which are – very important! – directly grounded in your data. Another advantage of time stamps lies in their timesaving potential. You can, e. g., create provisional transcripts first, and when it becomes clear which passages will be used for further analysis, transcribe only those in more detail.
Qualitative data analysis with f4analyse

Now your interviews are transcribed and available as text files. So how do you go about the analysis in terms of content? Specifically in the field of qualitative social research there is a great number of different approaches and methods of analysis. Depending on your methodological approach, these could consist in reading the text and working with comments and memos; a researcher might follow a hypothesis by means of a predefined code tree, identify metaphors, linguistic phenomena, facts, topics, motives and many more aspects – this list could go on and on. Unfortunately there is not one correct way for the evaluation of your data. Rather, you have to choose one that is adequate for your topic, your research question, your approach and your material. In any case, you have to consult the relevant methodological literature and read up on it.

You may ask yourself what you need in order to start with the analysis of your interviews or texts. We assume that, at this point, you have formulated your research question and found an adequate methodological approach. You have developed interview questions, tested them and have conducted and recorded your first interviews. You have further chosen a suitable transcription system and started typing your interviews in f4 (or you have someone else doing it for you). You know
which methodological focus you would like to apply to your textual data and have an adequate schedule with a time budget of total interview length times 100 (cf. Kuckartz et al. 2008, p. 75).

Based on our own experience, we have compiled a few common features of analysis that work across methodologies. We use them here to show you briefly what a possible and easy approach could look like. In principle both paper, scissors, markers and sorting boxes, and a QDA-software program work. We refer to the QDA-software f4analyse\(^{18}\) here, which we have specifically developed for an easy introduction to computer-aided qualitative analysis. Below we will show you a suggestion on how to proceed and how to implement the steps using the transcription software f4 and the features of f4analyse.

Simply put, most qualitative research projects contain five analytical steps (with different emphases):

\(^{18}\text{f4analyse is a QDA-software that contains essential features for the basic (content) analysis of textual data. It is easy to use and can be learned easily, too. It is suitable for many methodological approaches, e. g. Grounded Theory Methodology, qualitative content analysis according to Mayring (e. g. Mayring 2012), thematic coding or qualitative evaluations (cf. Kuckartz et al. 2008).}\)
- Data Preparation (typewriting)
- Reading and discovery
- Organizing
- Summarizing
- Reflecting and theory development.

**Data Preparation - Type what you hear.**

This step has already been discussed at length earlier in this handbook. It entails having chosen adequate transcription conventions, knowing and being able to apply them. After the transcription, the completed texts are available as rtf-files.

**Reading and discovery – highlight relevant passages and comment on them**

Read the completed transcript line by line. In doing so, correct mistakes. Always keep your research question in mind.\(^\text{19}\) Write down things that stand out about the whole text or the speaker. Comment on exciting passages in the margin.

\(^{19}\) Research questions are usually comprised of several parts. For simplicity’s sake we only speak of “the” research question in the singular form here.
If you work with f4analyse, import the texts into the program and record your thoughts in the comment field directly below the text. You can generate comments or paraphrases exciting passages by highlighting the passage and clicking on “memo”. Use the field that appears to note down your ideas, assumptions or things that are conspicuous. Your notes are assigned to exactly that sequence of words.

While you read your text for the first time, collect notes that sum up the main points. The best thing to do is to write down this summary as well, e.g. as a case summary in the comment field. It is the central location for all information relevant to the case, like basic data, memory minutes, facts and foci.

Commenting is analyzing

„Writing is a vital part of your analysis and is a continual process during your research... It is not a good idea to leave all your writing to what is often called a ‘writing-up’ stage. Start writing as early as you can... Writing is thinking... Writing is analysis... In a very real sense, writing up your notes and writing the final narrative account of your work are, especially in qualitative research, central parts of the analysis itself.“ (Gibbs 2010)
Organizing – develop a system and sort text passages and comments accordingly.

The next step consists of organizing your comments and highlighted passages. This is done with the aid of a code system that is divided into main codes and sub-codes. Passages of text are virtually cut out and pasted into corresponding codes. The code system can be derived in different ways: in a quantitative evaluation, for instance, one often creates a framework from the guiding questions and supplements them with the impressions after the first reading. You can then develop further codes by combining the research questions, reading the material, text interpretations and your increasingly differentiated perspective on the material (cf. Kuckartz et al. 2008: 36ff.). Berg & Milmeister (2011) and Mey & Mruck (2011) describe an open coding process within the context of Grounded Theory, that can be utilized in many research projects.

The person analyzing the data initially highlights all passages pertaining to the research question, without structuring the text in any other way

20 Depending on methodology they are also called keywords, indices, labels, topics or categories (cf. Berg & Milmeister 2011: 308).
In a second step, the text segments receive keywords or “labels” (cf. Berg & Milmeister, 2011). In this process called open coding, the implicit reasons one had in choosing a certain passage help determining the keywords. In a next step, the quotations thus generated are interrelated with one another and divided into main- and sub-categories.

In f4analyse you create a new code by clicking on the plus symbol in the right code bar. You can change the structure of the code tree at any time, using your mouse and the drag and drop feature. Each code can be assigned a different color. All codes of one thread should have the same color.

With this first code system you can now proceed to assign all relevant text or comment passages. The principle of reading and highlighting applies here, too. In f4analyse you highlight a passage and then click on the relevant code in the code tree. The highlighted text is then assigned to the respective code and underlined in that code’s color.

---

21 In Grounded Theory, these segments are often called “quotations”.
In the course of your analysis, some codes will be filled with many different text passages. In that case, check whether the passages can sensibly be structured into sub-codes. Like the first code system, these sub-codes can be derived from theoretical considerations or from the data itself. Imagine you have assigned many passages and comments to the code “motivation”. Read them and think about how to subdivide them, for instance as sub-codes “instrumental motivation” or “goal-oriented motivation”. Then go through all passages and assign them to these sub-codes. If necessary, further differentiate the sub-codes as well. With each differentiation your code system becomes more differentiated and more sophisticated.

When you double click on a code in f4analyse, all text passages and comments assigned to it are displayed. You can create sub-codes by clicking on the plus symbol in the respective main code. Then highlight a passage and click on the sub-code.

**Summarizing – focus the organized data.**

After you have read, commented on and coded your textual data along the lines of increasingly differentiated categories, you can record and
focus your findings. Do this in case and topic summaries. Your existing comments, codes and text segments will be a good start for this.

A case summary focuses on a text or an interview, respectively, in concise words; it is mainly descriptive at first, without making specific interpretations or comparisons just yet. You can condense an interview into a case summary and find a heading for it. Here’s an example:

**Example: case summary**

*Interview2: The skeptical comparator*

- reads many magazines before deciding to purchase.
- does not trust the statements of sales staff.
- has been interested in entertainment technology for years.

In f4analyse, write your case summary into the comment field underneath the text. Open the respective interview and record your summary.

---

22 Of course every summary or focus already contains an interpretation based on the perception and selection of the researchers.
For topic summaries, you proceed in a similar way; you just do not only refer to one interview but to a whole topic – focusing or condensing a code and its sub-codes.

In f4analyse you double-click on the respective code and all assigned text passages are displayed. You can now read them and write topic summaries into the comment field. Describe your definition of the code, add anchor examples (i.e. important quotations) or summarize any passage content in a structured way. The previous differentiation into sub-codes makes it easier to separate different aspects of the answers.

**Scour & derive theory ideas – compare, make connections, develop a theory or connections with a theory.**

So far, the texts have been segmented and commented on. Ideas have been noted down and the thus finely “dissected” material has been organized systematically through codes and summaries. The analysis, literally “separating a whole into its components”, is now complete. Now it is all about putting the components in relation to each other and comparing them. It is possible that the nature of these relations are determined by the research question, or that completely new ideas
or hypotheses may have surfaced during analysis that now can or must be confirmed by the data. The ideas and proceedings for this step are as manifold as the number of research questions.

f4analyse offers an overview of your material in a “distribution list”. Here, the number of codes for each text is listed in a table. Even if quantitative values do not say anything about text content, you will, for example, be able to see that some participants have spoken more about certain topics than others. Especially for a case or topic comparison it is important to go back to the specific statements. You get there by double clicking on the respective table cell. You can verify your assumptions directly on the material and write down your findings in the code or text memo. Finally you export your summaries as RTF files, in order to be able to use them in your research report. In the report you explain your findings and how they pertain to the research question.

**Features of f4analyse**

The following section describes the makeup and features of the QDA software f4analyse.
f4analyse has been optimized for small and medium projects with up to 30 texts, but more comprehensive projects are also feasible. All texts, codes, memos etc. are saved in a project file and erroneous steps can be undone. Results like transcripts, codes and memos can be saved as rtf-files and thus be used for the writing of the research report.

Since the textual data is at the center of f4analyse, it takes up the most screen space and is displayed in the center. The codes and texts are visible in the margin at all times. Texts are listed on the left and the code system is structured hierarchically on the right. Codes can be induced while reading or deduced from prior considerations. f4analyse offers ample possibilities for comments. Single words, passages, groups or codes can be commented on and also coded later on.

Switch between views in different work phases. The options are: detailed view, selective view, distribution and search.
Detailed view

In detailed view, f4analyse displays the text document or all text passages assigned to a code in the center. Double clicking on the respective text or code will open it directly. Clicking on the ‘plus’ symbol in the respective column creates a new text or code. You can now read your text and start to comment and code. Coded passages are underlined in the code’s color. Comments on texts can be shown or hidden. With the comments hidden, you have an unobstructed view on the original text. When the comments are shown, you can see the original text on the left und the comments on the right (like in a chat or message protocol), and you can check your conclusions and paraphrases. What is special is that all comments can be visible at all times, if you wish, and that they can be coded as well.

The significance of memos for analysis

“Not writing memos is the research equivalent of having Alzheimer’s disease, you may not remember your important insights when you need them.” (Maxwell 2005, 12)

Below the text or code content there is a comment field. For a whole text, you can write down your impressions of the interview or a case
summary. For a code, you can write down your definition with anchor examples or first ideas for interpretation.

For all those who need to transcribe first, the transcription mode can be activated with one click in the lower left. Text blocks, playback speed, wave shape, wind interval and the current time will be displayed (corresponding with the features of f4 mentioned above).

Image 1: f4analyse with opened text, comments and comment field below.

**Selective view**

In selective view you can filter the coded text passages and comments according to different criteria. You only want to read statements assigned to the code “motivation” from the interviews “Miller” and “Smith”, for instance. All matches are listed with references and can be commented, condensed, exported or used as a basis for further differentiating the code tree.
Distribution

Distribution view shows how often respective codes have been assigned. The table contains all texts and groups in the rows and all codes in the columns. The selection of texts, groups and codes can be modified. The cells contain the absolute frequency, e.g. how often the code “motivation” was assigned in interview 1. To read concrete statements you just have to double click. This facilitates quick access to passages relevant for the comparison of people or topics. If you should want to use the matrix in other programs like SPSS or Excel, save it in the CSV format.

Search

“Search” enables you to search your texts and/or comments for terms or combinations of terms. The results are listed as quotations and you can comment, code or export them as necessary. Of course it is also possible to assign all references to a new or an existing code, if it seems to make sense.23

23 Please note that passages dealing with a certain concept will not come up in a search if they don’t explicitly contain the search term. You will also “find” passages that contain the search term, but use the word in a different context.
You can find a complete guide to the program f4analyse as a PDF document on www.audiotranskription.de.

Tutorials and practical Hints

How to choose a recording device

Most qualitative researchers face the same question when preparing for their projects: Which recording device is best for recording my data? We had the same issue six years ago, when we (Thorsten Dresing and Thorsten Pehl) conducted our dissertation projects and started looking for a recording device for our own qualitative interviews. We tested all available gadgets ourselves, since no one else could provide us with a satisfying answer to this question. Ever since then, we have been testing recording devices and sharing the results with other researchers on our website http://www.audiotranskription.de/english. Our website provides an extensive and a consistently growing collection of recording equipment tests and comparisons of digital recorders. Today, we not only look for the best devices for interviewing, we also test and review equipment for recording music, ambient sound, dictation, nature sounds and more. In order to share more about our experience testing countless recording devices, we created
the following guidelines to help others choose a recording device for a qualitative research project.

**Recording quality**

Obviously, recording quality itself is an important issue. It is crucial what “gets into the ears.” However, there is no device with the ‘best’ recording quality. Many devices deliver outstanding recordings, though with different recording characteristics. Whether these characteristics are ‘good’ depends on the recording situation.

Let’s say you want to record narrators in order to create an audio book. This requires a voice recording which is as clear as possible and without ambient noises. There are devices that do this very well. But the same devices fail or do poorly when recording the sound of a drizzling rain or a chirping cricket.

You should always consider in which recording situation (e.g. interviews, ambient recordings, or music) and recording settings (e.g. in a studio or outside) you want to use the device. On our website, you can listen to sample recordings from several recorders (http://www.audiotranskription.de/english/fresh-sounds-in-2012). When listening, you should assess the sound quality with regard for the following four aspects:
How to choose a recording device

- **Voice & detail perception**: How good can you recognize & distinguish between the narrators and the sources of other sounds? The subtler, yet distinguished the nuances are, the better.

- **Noise level**: How strong and perceivable is the hissing and humming background noise, especially during quiet passages? The less, the better.

- **Perception of space**: How good is the impression of depth and space? Do you get the feeling that you are immersed in the recording situation or is the recording unnaturally flat? The more natural the space perception, the better the recorder is suited for recording atmosphere and group conversations; the more flat the recording, the better for recording individual speakers.

- **Representation of sound pitch (high and low)**: Are high or low frequencies emphasized? When recording individual speakers, a pleasant sonority, or depth of sound, is often preferred, for room atmosphere recordings, a clear emphasis of high pitches is preferable.

**Suitability for daily use (handling, battery life, craftsmanship and reliability)**
In our opinion, this is a very important issue. Can the device be operated intuitively? Are the important functions easily accessible? Is the display easy to read? Does the battery last at least for a working day? How is the recorder designed and constructed? Are there flimsy parts? Is the recorder made mostly from plastic or metal? Are the buttons easy to press or do they wobble around? All of these things can be easily assessed if you hold the recorder in your hand, but product descriptions and photos alone do not provide reliable information. To compensate for this, we also focus on handling aspects and haptic perception in the reviews.

From our experience distributing recording devices via our website, we can make a few assertions regarding the reliability of some recording devices based on those which have been returned to us under warranty for repair or replacement. We have noticed rather clear differences in product quality depending on the brand. Devices made by Olympus and Sony are very rarely sent back to us (fewer than 1 in 1,000), whereas products by Zoom and Tascam are returned more often. It must be duly noted, however, that this information is not universally valid for all devices and only applies to those we distribute.

Recording & file formats
For transcribing qualitative interviews and group discussions, MP3s provide an appropriate compromise between file compression, recording quality and flexible (cross-platform or cross-computer) file handling. Please make sure to use a set (not a variable) bit rate when generating an MP3 file. The WMA file format is equivalent to MP3s in terms of sound quality, but it cannot be played on Macs without certain limitations. In principle, uncompressed recordings in PCM-WAV format can be used, but they barely provide quality advantages in interview settings and consume up to tenfold of the space on your computer or USB stick. A good many other audio and video formats are easily and quickly converted using free software.

If your data requires more complex processing, such as phonetic analysis or signal analysis, it is important that the recordings are available as uncompressed WAV files. Also, if your recordings are to be made available at a later date for linguistic databases, it is preferable to use WAV format. Archives (such as the LDC in the USA, the ELRA in Europe, the BAS and IDS in Germany, and the MPI Nijmegen (for ethnological recordings)) require a file format which is open access and cross-platform, and which can be produced and used free of licensing while guaranteeing optimal quality. In practice, these demands mostly lead to using the WAV format. If you are interested in learning how to transform audio files, please refer to the chapter ‘Converting audio files’ in this manual.
DSS and DSSPro file formats used in dictaphones are unsuitable for transcription in the context of qualitative research or linguistic research. The sound quality is substandard and the file format requires proprietary software and hardware. Please note that converting these files into MP3s at a later point does not improve the sound quality.

**External input**

Current audio recorders usually have good internal microphones; for recording interviews and group discussions no additional external microphones are necessary. However, in certain situations, being able to connect an external microphone may be a positive aspect when choosing a recorder. Does the device feature a line-in as well as a separate microphone input (which is preferable)? Does the device offer genuine inputs for XLR-microphones with phantom power or only a 3.5mm jack plug? A 3.5mm jack plug can be flexibly used with many types of microphones: for instance with some lavaliere-style microphones or with the output from a Hi-Fi-system for the purpose of digitalization. XLR-microphone inputs are vital for professional vocal microphones and for connecting to mixing consoles. The inch-thick XLR-plugs lock in firmly and they are suitable for situations calling for more a more sturdy connection.
Important functions

Long lists of device functions can easily be found in the product descriptions. In the case of recording interviews and group discussions, “automatic level control” is a term you should pay attention to. This means that the recording volume is automatically adjusted by the device. This is important if you don’t want to be constantly glimping at the fader controller/meter while recording. The adjustments of this automatic level control can be perceived as light volume fluctuations. This is great for interview recordings, however, it is not recommended for music recordings.

Accessories and cost

For a good interview-recording device you should at plan a budget of roughly 200 Euros or 300 Dollars. When comparing prices, we recommend that paying attention to the accessories that come with the device because these may explain a higher price range. For recordings outside, we absolutely recommend a windshield. Even a slight breeze can make the recording inaudible. The sponge windscreen supplied with some devices does not always provide effective protection.
Sample recordings

If you consider these aspects you will reliably be able to choose the best recording device for YOUR purposes. The necessary information you need for that can be gathered from our many current (older) comparisons and individual tests on digital recorders. We compile these test reports with a lot of pleasure and using our ears – not on the basis of frequency measurements or technical data sheets. We listen “blindly“ to sample recordings as a team and evaluate every recording individually. Afterwards we discuss, as a team, the results. Thereafter, we reveal/disclose which devices belong to the respective recordings. You can retrace our results for each device and even listen to sample recordings on:

Hints for recording & handling files in particular situations

At www.audiotranskription.de, researchers have repeatedly contacted us with technical questions concerning recording and transcription issues they have come across in their research practice. We have tried to answer most of them, and we would like to introduce some of them, all of which come from the collection of tutorials available on our website. We hope that our technical hints will save you some time and effort, or even open up some new possibilities, for your research.
**Recording telephone interviews**

Telephone interviews are an important and cost-efficient method of data collection. In the case of phone interviews, the technical task is to record both speakers in a reasonable quality. However, the recording quality will always be worse than the recording of a face-to-face interview recorded by a recording device.

With our small phone recording adapter, telephone conversations can be easily recorded. The cable of the receiver has to be connected to the telephone by a plug. Detach this plug, place the adapter in between. Now connect the adapter’s jack plug with the line-in of your recording device. Now you are ready to record all phone conversations.

Alternatively the adapter can be connected to your computer’s microphone input, and the telephone conversations can be recorded via recording software. We recommend free programs such as Audacity, No23 Recorder or RecOnPhone. A noise filter ensures good quality even in soft-spoken passages. When recording the phone conversation with a computer, basic knowledge of the control panel may be necessary in order to modulate the optimum recording level.

Another alternative is the telephone adapter (TP-7) manufactured by Olympus, which we do not necessarily recommend due to its uncomfortable handling and its hygiene issues. If you use this device, the type
of the phone (wireless phone, cell phone, phone connected with wire) does not matter because the adapter is worn in the ear, just like a small set of headphones.

However, inserting the adapter in the ear is rather uncomfortable, and due to hygiene reasons it is less suitable if it is to be used by several persons (e.g. if it is to be rented out by a library or a department).
Recording phone conversations with Skype

Phone calls can be easily recorded if you conduct your phone interviews via Skype. There is a series of add-ons and programs which allow you to record phone conversations as well as conversations with other Skype users. You’ll find a commented list of Skype recorders on http://www.aboutonlinetips.com/free-skype-call-recorders-3308/

This guide will introduce you to the free “Mp3 Skype Recorder”, which – as the name suggests – saves your conversations as mp3 files. If you want to try out different programs: We have created two video tutorials on using two other recorders, “wiretap” & “callgraph”. The tutorials are available on audiotranskription.de (German only).

Although recording via Skype can make the recording of phone/VoIP data much easier, there is also a range of possible technical issues. The call quality when using Skype can dramatically diverge, depending on your internet and computer speed. If you call another Skype user, his/her internet quality and computer speed will also drastically influence the call quality. If the connection is bad, you and your interviewees might sound very choppy, break up, sound somewhat “distant” or distorted, and there might be a delay or echo when speaking (especially if you or your interviewees use speakers instead of earphones). These technical issues can make interviewees feel less comfortable with the overall interview situation or leave them somewhat confused – especially if your interviewees are not familiar
with VoIP technology and its deficiencies. If you suspect sound issues you should explain prior to the interview that you are calling from a computer, and that your voice might sound choppy sometimes, or that the conversation might break up – but that you’ll call again right away. Before you start to conduct interviews via Skype you should therefore not only make sure that you and your interviewees feel comfortable with the mode of communication – but also check if you and the interviewees are familiar with the technology (and problems) connected to it. For some additional methodological remarks on Skype interviewing, see http://squaremethodology.com/2011/01/initial-thoughts-on-interviews-via-skype/

**What you need**

- Skype is free, and it is free to call other Skype users. If you want to call phones from your computer, you need to buy calling credit from Skype.
- A microphone & headphones (or a headset). We do not recommend using speakers, because they sometimes create annoying feedback. (If you interview other Skype users, you should make sure your interview partners have a microphone & headphones as well...)
- “Mp3 Skype Recorder” (free), download: http://voipcallrecording.com
Installing and setting up the recorder

Download the recorder and install it on your computer. Start the recorder, and then start Skype. During the very first start, Skype will ask you whether you want to allow the recorder to connect with Skype – click on “yes” at this point. Depending on your firewall settings, a warning might pop up, informing you that the recorder is trying to access Skype. You will have to allow this; otherwise, the recorder will not be able to record your calls.

If you want to change the recorder’s access to Skype at a later point: You can manage the access of external programs in Skype under Tools -> Options -> “Advanced” tab -> “manage other program’s access to Skype”.

Recorder options

To record a Skype phone call or a conversation with another Skype user, Skype as well as the recorder have to run.

The recorder functions are pretty straightforward: You can change the bit rate of the recording, and you can choose whether you want to record mono, stereo (caller on one channel, called person on the other) or joint stereo. Furthermore you can specify whether the program should start on Windows startup, and you can change the
folder in which the program stores your conversations (which we recommend since the default folder is somewhat hidden). The conversations will be saved as mp3 files.

**How to record**

The recorder can be set up to start a recording as soon as your conversation partner picks up (We strongly discourage this setting, because it might lead to accidental recordings without the interviewee’s prior consent). If the recording button has no square around (click on the recording button prior to the Skype conversation), the recording will automatically start as soon as the next Skype conversation starts (note that the recorder is not recording prior to the call).

If the recording button doesn’t have a square surrounding it, the recording will NOT start on start of the conversation – you can start it manually whenever you want to during the conversation. If the player
is set up like this and not recording, you will see a red bar on the bottom of the recorder with the message “recording off”.

Every time a recording is started, this window will pop up for a short time (check the bottom right of your screen), indicating that you are actually recording:

The recording will stop either when you push the stop button or when you hang up your call. The file will then be automatically saved – another pop-up window will inform you of that. The file will be saved in the location that is shown on the player.

Before calling your interview partners, you should do some test calls in order to get acquainted with the controls, and to make sure the quality is alright.
Converting audio files

It is sometimes necessary to convert your recordings, for instance if you work on a Mac, but your interviews are saved as WMA file; or if you have an uncompressed recording from a high quality recorder which leaves you with a file of over 500 MB.

For converting audio files, we recommend programs such as Audacity (Mac and PC), all2mp3 (Mac), Switch and xrecord. They are perfectly able to convert audio recordings into other formats (e.g. mp3). We will show you how easy file conversion is by example of the software Switch\(^{24}\):

1. **Select audio file**

Install and start Switch. Select the files you want to convert or drag the files into the open program window. It is also possible to select various audio recordings or a whole folder.

2. **Specify the destination and format**

On the lower part of the program window specify the preferred output format, for example OGG or MP3. You can indicate the preferred output folder in the input field above.

---

3. Converting

Upon clicking on the ‘convert’ symbol (top right), converting begins. This process can take a few minutes depending on the file size. If you convert files into MP3s, a window for the codec settings is displayed first. Click on ‘OK’. The conversion is complete when the progress bar reaches 100 percent. The file will be located in the folder you previously selected.

Noise Removal

With the free software Audacity (http://audacity.sourceforge.net/), which supports all common audio formats, it is possible to reduce noise from an audio recording easily and within a few clicks. The procedure is as follows:

1. Determine the noise profile

Install and start Audacity, open the interview via the the ‘File’ menu. You can now see the file in waveform. You can listen to the file by clicking the “Play” button; a vertical bar indicates the current position in the file. In order to skip to a certain position, just click on the waveform. Search for a position where you only hear background noise (for
instance, a short conversation break), select the part that’s silent except for the noise. Then choose ‘Noise Removal’ from the ‘Effect’ Menu and click ‘Get Profile’.

2. Remove noise

Select all of the audio (CTRL + A), choose ‘Effect’ > ‘Noise Removal’ again. This time, select the “Noise Removal” button. Now click on ‘preview’

3. How to get optimal results

In order to optimize the result, you can experiment with adjusting the noise threshold with a different noise removal level. If you get a satisfactory result, click on ‘OK’.

4. Finishing up and exporting

In order to finalize the changes in the audio recording, the project must be exported. Go to the ‘File’ menu and choose ‘Export’. If necessary, add metadata to your file and confirm with ‘OK’. In the subsequent window, select your preferred file type (most commonly MP3) and the saving location.
Trimming audio files

Sometimes a recording contains unwanted content from before or after the interview itself. For trimming audio files, we also recommend Audacity for trimming audio files.

1. Selecting a file

Install and start Audacity, open the interview via the ‘File’ menu. You can now see the file in waveform. You can listen to the file by clicking the ‘Play’ button; a vertical bar indicates the current position in the file. In order to skip to a certain position, just click on the wave form. Highlight a selection you want to cut by holding the left mouse button and moving the mouse.

2. Trimming

You can delete the selected part by pressing the ‘Del’ key on your keyboard.

3. Cutting and exporting

Would you like to store the actual selection as a separate file (For example; as a sound sample for a transcription service)? Select the ‘File’ menu, then ‘Export’. Your snippet will now be shown in a new window.

4. Finishing up and exporting
In order to finalize the changes in the audio recording, the project must be exported. Go to the ‘File’ menu and choose ‘Export’. If necessary, add metadata to your file and confirm with ‘OK’. In the subsequent window, select your preferred file type (most commonly MP3) and the saving location.

Data security and recovering deleted data

Deleting data by mistake is annoying. Whether it is the important interview, the written transcript or any other data; once deleted unintentionally, one can be sure of a surge of adrenaline. Fortunately, there is a free tool that can help in such a situation: Recuva.

1. Make preparations

If possible you should not save additional data on the drive where the deleted data is located – at least until the recovery is complete, so that the lost data is not overwritten. Download and install the software from: http://www.piriform.com/recuva.

2. Using the wizard for recovery

Open Recuva and use the wizard. It is best to search for all file types. In the next step, make sure that ‘in-depth scan’ is activated - only then Recuva can really find most of the data.

3. Searching and restoring lost data
The search itself can take between ten minutes and several hours (400 GB hard drive approximately takes 6 hours to scan). The search result is listed in a table, from which you can select single, several or all restorable data and save it onto another drive. After selecting the files, press the button ‘recover’ and all the selected data is restored – impressive.

An important conclusion

While we were very happy with the results Recuva delivered, we found out something interesting. You can restore nearly almost all data with Recuva. Not only data that was deleted an hour ago can be restored, but also data from a completely formatted hard drive (which had been used earlier).

Not a problem? But yes! Think about the following situation:

You sell your old notebook, your external hard drive or your USB flash drive. The buyer has the possibility to restore data with Recuva and therefore can get into possession of information that was not meant to be his or hers.

Or: You have a rental recording device. In this case, every subsequent user can at least recover and listen to a part of previously deleted interviews.
After consulting computer scientists we realized that empty and formatted storage media are never completely empty. If you deal with sensitive information such as interviews (which are subject to privacy policies and informed consent agreements), analysis results, images and much more, you cannot pass your data storage hardware on to someone else without making sure that the data is permanently deleted.

**Deleting data safely (permanently!)**

Overwriting data once should normally do the job. It is also sufficient to simply delete the sensitive data and then to fill the device to the brim with useless data manually.\(^{25}\)

Repeated overwriting is not necessary in the case of magnetic hard drives or flash memory drives. In the case of flash drives it might happen that some data is retained in flash cells that only serve as buffers or as replacement of defective cells.

The probability that something usable remains in these cells is on one hand very low, and it would, on the other hand, call for a huge effort to retrieve the data. Our recommendation is to use a special deletion program. “Eraser” is a good solution, which is recommended by the

\(^{25}\) The program “H2testw v1.4” provided by the computer magazine c’t fills storage memory completely upon testing hardware and should be able to overwrite all data: [http://www.heise.de/software/download/h2testw/50539](http://www.heise.de/software/download/h2testw/50539)
computer magazine c’t and the German Federal Commissioner for Data Protection and Freedom of Information

But if you have *really* sensitive data, you should destroy flash-media (and of course CDs) physically.
Cited works / References


The authors

Dr. Thorsten Dresing: Education scientist - co-founder of audiotranskription.de, researcher in the department of educational science at Philipps-University Marburg Germany (Prof. Dr. Udo Kuckartz, 2000-2008). Finished PhD in 2006, lecturer for MAXQDA lecturer since 2000.

Contact: thorsten.dresing@audiotranskription.de

Thorsten Pehl: Education scientist, co-founder of audiotranskription.de, Coach & consultant for qualitative data analysis, digital recording technology and transcription. Lecturer for f4analyse an QCA.

Contact: thorsten.pehl@audiotranskription.de

Christian Schmieder: Sociologist & Linguist, coach & consultant for qualitative data analysis software and qualitative methodology. PhD student at UW Madison's Games+Learning+Society Center / Department of Curriculum & Instruction under Prof. Constance Steinkuehler. Qualitative Research Software consultant at UW Madison's Social Science Computing Cooperative (SSCC) & Software Training for Students (STS) program.

Contact: cschmieder@squaremethodology.com

Special thanks go to our whole team at audiotranskription.de, and to Christian Spengler. Special thanks also go to Jesse Henderson and to the many readers who helped and supported us in creating this manual.

We wish all our readers the best success with their recordings, transcriptions and their research. If you have any questions or feedback – it would be great to hear from you!

Marburg (Germany) & Madison, Wisconsin (USA), January 2015